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28 September 2016

Foreword

Over the years, Information and Communication Technology (ICT) has greatly 
impacted all aspects of our lives. With the emerging new technologies, the world 
has become more connected and information more digital, greatly influencing the 
way people learn, live, work and communicate. Learning in and for the 21st century 
requires today’s students to be discriminating users of information, creative problem 
solvers, skilled creators of knowledge, and effective communicators.  Literacy with 
ICT is increasingly becoming an essential skill to participate productively in the 
21st century knowledge society, in addition to the conventional literacy of reading, 
writing, and numeracy.

The existing ICT curriculum in schools was introduced in 2002 to equip students with 
knowledge and skills relevant for the world of work then. The needs have, however, 
changed over the years but the curriculum has not been able to maintain pace with 
the change, especially in the area of emergent and immersive technologies such as 
social media.

The development of new ICT curriculum has been in progress since 2014 to 
address the curricular gaps mentioned above. Drawing ideas and inspiration from 
various international educational technology standards and best practices, the ICT 
Curriculum Framework for Classes IV to XII was developed in 2014. Based on the 
framework, the writing of textbooks from classes IV to XII was initiated from 2015.

The approach adopted in the new textbooks is a departure from procedure-
oriented teaching and learning. The textbooks are designed with emphasis on 
“competencies” – being able to “do” than “know”, thinking critically, being analytical, 
solving problems and creating knowledge by sharing and communicating with each 
other.

I am hopeful that the new curriculum will pave the way forward in our continuous 
strive to understanding the risks of the digital world as well as its opportunities to 
achieving the promises of technology to transform learning and living.

(Kinga Dakpa)
DIRECTOR

P.O. Box 1243, Shari, Paro–12001, Bhutan     Tel: (Director) +975-8-272561     (PABX) +975-8-271226/271632/271214
Fax: +975-8-271991         Toll Free: 185          Website: http://www.curriculum.bt

རྒྱལ་འཛིན་ཤེས་རིག་ཚོགས་སྡེ།
Royal Education Council

Paro : Bhutan
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INTRODUCTION
The present society is characterised by its focus on information its 
creation, dissemination and utilization. It lays emphasis on knowledge to 
drive economy by fostering innovation and entrepreneurship. Information 
and Communications Technology (ICT) plays an important role in making 
the needed information and knowledge easily accessible. ICT has become 
an important enabling tool to create and share information in this 21st 
century society.

Increasingly, children will be exposed to ICT in their daily lives. Education 
also must move forward to bring essential ICT skills to classrooms so that 
children can participate effectively in knowledge society. 

ICT education has moved from ICT literacy to literacy with ICT, from 
“demonstrating ICT skills to choosing, using and sharing ICT, responsibly 
and ethically, to support critical and creative thinking about information 
and about communication across the curriculum” (Literacy with ICT Across 
the Curriculum, 2006). This shift does not belittle the importance of ICT 
literacy. It still is an integral foundation of literacy with ICT.

Literacy with ICT provides our children with the skills and knowledge they 
need to take part in inquiry in knowledge society. Children learn to discern 
information critically, produce knowledge creatively, and collaborate 
with others. Being able to produce information is not enough. Using ICT 
responsibly and safely is a vital attribute of a good ‘digital citizen’ in the 
21st century. 

Although literacy with ICT will be taught as a separate subject, the 
emphasis is on applying the skills across the curriculum. Where possible, 
attempts have been made to integrate topics from other subjects to 
provide authentic learning to children.
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USING THE TEXTBOOK
Each chapter starts with learning objectives to inform both students and 
teachers of content they are going to deal with. Student activities are 
interspersed in the chapter for students to link prior knowledge and skills 
with new content, or to practise new skills after teacher demonstrations. 
Activities are of two types: Try This on Machine, which requires use of
computer, and simply Try This, which generally involves individual or group
work without the use of computers.

The main learning points covered in the chapter are summed up in Now You 
Know. The Check Your Progress at the end of chapter checks for the
student’s general understanding of knowledge and skills covered. Activities 
are mostly straight forward. There are another type of student exercises 
listed under Explore Further towards the end of the chapter. These
exercises are designed to extend the knowledge and skills beyond what 
students learned in the chapter. Often the exercises are set in context 
of the content from other subjects to promote authentic, interdisciplinary 
learning. The idea is to use ICT as an enabling tool to explore learning 
across the curriculum.

Some secondary information related to the topic are shown in boxes as 
Do You Know?, Caution and Tips boxes are used to inform students of
risks, and words of advice or useful information. Where there is a need 
to inform the teacher of preparation required, a Teacher’s Note callout is
provided in each chapter. There is also a section of web links given at the 
end of each chapter for teachers to check out on the chapter topics. 

Finally, there is the End of Year Activity which is similar to Explore
Further exercise except that it requires children to apply the key skills 
they acquired over the year. Teachers may choose to create their own 
activity, modelled on the sample activity included in the book.
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The book is so designed that it can be covered in one year, with one 
class per week. 

The table given below is an overview of the concepts, skills and values 
covered in each chapter.

Chapter Knowledge Skills Values Weeks

1. Hardware
and File
Management

 - Internal hardware 
of computer

 - File and folder 
management

 - Organizing files using 
folders and sub-
folders

 - Navigating in 
computer, and 
managing files and 
folders

 - Systematic 
organization of 
files and folders

3

2. Advanced MS
Word

 - Cell, row, column 
and table

 - Header and footer

 - Objects (clip art, 
WordArt, shape, 
picture) and special 
characters

 - Text wrap

 - Document 
.protection

 - Organizing and 
formatting 
information in a table

 - Creating and editing 
header and footer

 - Inserting and 
formatting text

 - Flowing text around 
objects

 - Setting password to 
a document

 - Visual 
organization and 
presentation of 
information

 - Security of a 
document

5

3. Connect and
Collaborate

 - Network and its 
usefulness

 - Internet

 - Structure of web 
address

 - Online collaboration

 - Using Google 
Classroom

 - Collaborating 
on a project 
using Google 
Classroom

4

4. Communicate
with Email

 - Email

 - Compose, reply, 
forward and delete  
email

 - Email etiquette

 - Using Gmail to 
communicate and 
manage emails

 - Following 
correct 
etiquette while 
drafting an email

4
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Chapter Knowledge Skills Values Weeks

5. Computer and
Health

 - Pain and strain 
resulting from 
poor computer 
ergonomics

 - Correct postures

 - Practising correct 
postures and good 
habits

 - Following 
correct 
postures

 - Following good 
habits and 
practices

2

6. Searching on
the Internet

 - Types of search 
(keyword, phrase, 
Boolean)

 - Online citation

 - Using different 
search strategies

 - Citing online source 
of information

 - Acknowledging 
other people's 
ideas and works

3

7. Interaction in
Scratch

 - Control blocks

 - Events blocks

 - Coordinates

 - Operator blocks

 - Sensing blocks

 - Algorithm

 - Using Events blocks 
to communicate 
between Sprites

 - Using Sensing blocks 
to interact with the 
user

 - Using coordinates 
to move Sprites 
precisely

 - Using Operator 
blocks to perform 
mathematical 
calculations

 - Writing a good 
algorithm

 - Using algorithm 
to solve 
a complex 
problem and to 
make program 
efficient

6
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HARDW
ARE AND FILE MANAGEMENT

In this Chapter
1.1  Internal Hardware
1.2  File Management
1.3  Windows Explorer

Learning Objectives
1.  Identify internal hardware

components of the computer.
2.  Describe the functions of internal

hardware components.
3. 	Use	folders	to	organize	files	in

computer.

1
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1.1 Internal Hardware

In class five, we have learned about the external computer components 
such as monitor, mouse, keyboard, printer, scanner, and projector. 
We have also learned that the CPU is a component located inside the 
System Unit. In addition to the CPU, there are many other components 
inside the System Unit. These components found inside the System Unit 
are called internal hardware or internal components. We will look
at some of the internal components of a computer (Figure 1.1).

Motherboard

Motherboard is the main circuit board to which all other components are 
connected. It allows all the parts of the computer to communicate with 
each other. CPU, hard disk, heat sink, power supply, and memory are 
connected to the motherboard as shown in Figure 1.2.

Figure 1.1. Internal hardware components
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RAM slots

Hard disk and optical 
drive connectors

Power connector

CPU and heat sink 
mounting point

Expansion slots

Exte
rnal ports

CPU (Central Processing Unit)

CPU, also called processor, is a piece of hardware in a computer which 
performs calculations or carries out all instructions. Therefore, it is 
considered as the brain of the computer. The faster the CPU completes 
the calculations or instructions, the better it is. CPU has three main 
parts: Arithmetic Logic Unit (ALU), Memory Unit and Control Unit as 
shown in Figure 1.3. 

CPU

Input

Control Unit

Arithmetic and 
Logic Unit

Memory Unit

Output

Figure 1.3. Parts of CPU

Figure 1.2. Motherboard
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Some common CPUs are Intel Core i3, Intel Core i5, Intel Core i7, AMD 
Athlon and AMD Opteron.

Figure 1.4. Central Processing Unit

Heat Sink 
The heat sink (Figure 1.5) is a cooling device that prevents the CPU 
from getting too hot. Overheating damages the processor. A fan is also 
commonly attached to the heat sink to remove the heat fast.

Heat sink Fan

Heat from CPU 
flows to heat sink

Heat sink removes 
heat

Fan sucks in cold 
air

fan

heat sink

CPU

Figure 1.5. Heat sink
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SMPS
Switched Mode Power Supply (SMPS) shown in Figure 1.6 is the power 
supply unit for a computer.  It converts and distributes required power 
to various parts of a computer. It has fans that remove the heat 
produced by SMPS.

Figure 1.6. SMPS

Memory
Memory (Figure 1.7) stores data and instructions on which computer is 
currently working. It has limited capacity and data is lost when power 
is switched off. It is also called primary memory, main memory, system 
memory or Random Access Memory (RAM).

Figure 1.7. RAM
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Hard Disk Drive (HDD)

Hard disk drive (Figure 1.8) is the main storage device of the computer. 
In short, it is also referred to as hard drive or hard disk. The computer 
operating system, software and files are all stored in it. It stores 
information even when its power source is turned off. Computers can 
have one or more hard disk drives.

(Top view) (Bottom view)

Figure 1.8. Hard disk drive

Optical Disk Drive (ODD)
An optical disk drive or optical disk (Figure 1.9) is any storage device 
that uses light to read and write information. Common optical disk drives 
are CD, DVD, and Blu-ray drives.

Figure 1.9. Optical disk drive
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Expansion Slots
Expansion slot (Figure 1.10) is a connection point on the motherboard 
where additional components like sound card, video card, network card 
and modem can be added to increase the usefulness of the computer. 
Nowadays, these components are built in the motherboard. 

Expansion slots

Figure 1.10. Types of expansion slots

Try This
1. Name the device for each of the functions given below:

(a) All internal and external components are connected to it.
(b) It performs all types of processing.
(c) It prevents the processor from getting overheated.
(d) It controls and distributes current to different parts of

computer.
(e) It holds data and program on which we are currently working on.
(f) It allows adding more components to the motherboard.
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1.2 File Management

We know computer can store many files. It is important for us 
to organize files in the computer so that we can easily find them. 
Organizing files involves naming and arranging files and folders. This 
is called as file management. In a computer, files and folders are
organized in the form of a tree diagram similar to one shown in Figure 
1.11.

Figure 1.11. Tree diagram of files and folder organization
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So how do we organize our files? Given below are some ways to do it.

1. Use subfolders
Create necessary subfolders to organize files. Example of a good use 
of subfolders would be having Notes and Question Paper folders in 
Schools folder as shown in Figure 1.12.

Figure 1.12. Folders and subfolders

However, it is a good practice to avoid creating many subfolders 
because it can be tiring to open folder after folder to locate your file. 

2. Organize files and folders by category
It is a good practice to keep related files in appropriately named folders 
such as an example shown in Figure 1.12.

Figure 1.13. Organizing folders by category

3. Use meaningful names for files and folders
Names of the files and folders should be brief and appropriate so that it 
is clear what it contains.

4. Remove unwanted files and folders
Files and folders that are not required should be deleted to free hard 
disk space.
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1.3 Windows Explorer

Windows Explorer is a tool that helps you to navigate in computer and 
manage files and folders easily. We can open Windows Explorer using 
any one of the following ways:

 \ Start  >  All Programs  >  Accessories  >  Windows Explorer

 \ Right click on Start button and choose Open Windows Explorer

 \ Use keyboard shortcut Windows key + E

A. Parts of Windows Explorer

Figure 1.14. Windows Explorer 

 Navigation Pane
Used to access folders, libraries, hard disks and different location on 
computer.
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 Content Pane
Display files and folders within the location selected from Navigation 
pane.

 Details Pane
Shows number of folders in selected location and to see the most 
common properties of the selected file. Properties include file name, 
creation date, and size of file.

 Toolbar/Command Bar
Used to perform a variety of tasks related to managing and organizing 
the files on your computer. For example, you can use the toolbar to cut, 
copy and paste files.

 Back and Forward Button
Navigate to other folders or libraries you’ve already opened without 
closing the current window.

 Address Bar
Displays your current location as a series of links separated by arrows.

 Search Pane
Used to search files and folders on computer.

 View Options
Options to change the view settings for the files and folders, and how 
folder contents are displayed.

 Preview Button
Used to either show or hide the Preview pane.

 Preview Pane
Displays the content of the file selected from the Content pane.
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B. Navigating within Windows Explorer

1. To View a Folder
Click on the folder in the Navigation pane. All the files and folders inside 
the selected folder will appear in the Content pane.

You can also view the contents of a folder in Navigation pane by 
clicking on the wedge. Click on the white wedge  before a folder to 
expand the view and see all the subfolders as shown in Figure 1.15. The 
contents are displayed in the Navigation pane itself.

Figure 1.15. Expanding a folder in Navigation pane

Once expanded, the wedge will turn black. Click on it to collapse the 
view and hide all the subfolders. 

Figure 1.16. Collapsing a folder in Navigation pane. 

2. To Find a File or a Folder
1 Open the Windows Explorer.

2 Click on Documents 
Look for the required files and folders from the Content pane. 
OR 
Type the name of a file or folder in the search box 

 and press the Enter key.
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3. To Create a Folder
1 Open the Windows Explorer.

2 Select the folder from the Navigation pane.

3 Click New Folder on the toolbar 

4. To Copy and Paste a File or Folder, or Move a File or
Folder

1 Open Windows Explorer.

2 Select files or folders you want to copy or move.

Tips
 \ Click the first file, press and hold S key, and click the last

file. All the files in between will be automatically selected.

 \ Click the first file,  press and hold C key, and click another file

to randomly select the files.

Click on Organize on the toolbar (Figure 1.17) and choose the required 
option.

Keyboard Shortcuts

Use Ctrl + C to copy 
and Ctrl + V to paste 
the selected files and 
folders.

Figure 1.17. Copying or moving folder from Windows Explorer
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Try This On Machine

1. With Dzongkhag as main folder, group and organize the following into
folders and subfolders.
Education, Health, Forestry, Agriculture, Mushroom Centre, Aids, Books,
Tuberculosis, Firewood , Cancer, Teachers, Dairy Farm, Tree

2. Using Windows Explorer, create a folder called ICT and create
two subfolders Class Work and Home Work in it. Add a subfolder called
Chapter 5 in the Class Work folder.

(a) Create a blank text file My Funny Story in Class Work folder. Copy
the file to Home Work folder.

(b) Rename the copied file to My School. Open and type this text:

My school name is Zangtherpo PS. It is in Bumthang Dzongkhag.  I love my
school because it is beautiful and near Kurje Lhakhang. Save and close
the file.

(c) Using search box, find all your files or folders whose names start
with letter m.

(d) Delete the file My Funny Story.

(e) Search for all files and folders whose names contain the word
school.

(f) From the Recycle Bin, try and restore the file My Funny Story to
its original folder.
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Now You Know

1. CPU, motherboard, hard disk, memory, and SMPS are the internal
hardware components.

2. Motherboard connects all the hardware in a computer system.
3. CPU consists of Arithmetic Logic Unit (ALU), Memory Unit and

Control Unit.
4. RAM is a temporary memory.
5. Data processing in the computer is done by the CPU.
6. Heat sink cools the processor and SMPS fan cools the SMPS.
7. Organizing files and folders helps to find files easily.
8. Windows Explorer helps us navigate through the content, and work

with files and folders in an easy manner.
9. Files can be organized by categorizing them into appropriate folders

and subfolders.
10. Name of the files and folders should be brief and meaningful.

Check Your Progress

1. State True or False for the following:

(a) We should not use folders to manage files.
(b) SMPS removes the heat generated by the CPU.
(c) Your deleted files go to Recycle Bin before permanently

deleting from your computer.
(d) A folder can contain another folder in it.
(e) Keeping related files in one folder is the correct way to

organize them.
(f) Hard disk is the primary memory of the computer.
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2. What are the main parts of CPU?

3. There is a component inside the system unit that connects all other
components of the computer. What is it called?

4.  Which part processes commands given to the computer?

5.  Why does a computer need memory?

6.  Explain the importance of heat sink.

7.  Solve the crossword puzzle using the clues given below.

ACROSS

3 All other components are connected to it.

5 Temporary space to store files.

7 It supplies power to all components inside the computer.

8 It is used to remove heat from CPU (2 words).

DOWN

1 A group of related files are placed in here.

2 Data stays here even when power is turned off  (2 words).

4 Deleted files are go there (2 words).

6 The brain of the computer.
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Caution
 \ Do not open the system unit on your own. There is danger

of electric shock. Always switch off and disconnect the 

power supply to the computer.

 \ Do not touch the internal components. They may get

damaged from static electricity.

17Reprint 2019

Explore Further

Request your teacher/parents to open the system unit of a computer. 
Identify the components that have been discussed in this chapter. 
There are many other components which you would like to find out. Find 
out and write down the names and functions of various other parts.
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Web Links

1. Motherboard
 K http://www.learning-about-computers.com/tutorials/

motherboards.shtml

2. System unit and its components
 K  http://www.slideshare.net/adpafit/system-unit-its-

components-15286379?next_slideshow=1

3. Primary memory
 K http://www.computerhope.com/issues/ch001361.htm  

4. Components of system unit
 K http://www.slideshare.net/chrisgreeny/system-unit-

components-6610171?next_slideshow=3

5. Hardware and file management
 K http://www.helsinki.fi/tvt-ajokortti/ICT-Driving-Licence_UH_

EN_2014-09-30.pdf
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ADVANCED MS W
ORD

In this Chapter
2.1  Tables
2.2  Header and Footer
2.3  Pictures
2.4  Clip Art
2.5  Word Art
2.6  Shapes

Learning Objectives
1. Use tables in a document.
2. Format objects in a document.
3. Insert header and footer.
4. Protect document with a

password.

2
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2.1 Inserting Objects 

You have learned to type and format text in MS Word in class five. But 
you can do more in Word. We can also add objects like Tables, Pictures, 
WordArt, Clip Art, Shapes and Symbols in the document. Let us learn to 
add and format these objects. All of these objects can be found under 
Insert tab in Word as shown in Figure 2.1.

Figure 2.1. Insert Ribbon

2.2 Tables

A table consists of rows and columns. It is used to organize and present 
text, numbers and graphics in an easy to read manner. Each box is called 
a cell where we enter the information. The table shown in Figure 2.2 
consists of 4 rows and 3 columns.

Figure 2.2. An empty table
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A. Inserting Table
1 Position the cursor in the document where you want to insert a 

table.

2 Go to Insert tab > Table > Insert Table (Figure 2.3).

Figure 2.3. Inserting table

3 Under Table size, enter the number of columns and rows required as 
shown in Figure 2.4.

Figure 2.4. Setting number of columns and rows for a table
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4 Click OK.

B. Adding a Row or a Column
You can add a row or a column anywhere in the table. 

1 Position your cursor in the table.

2 Go to Layout tab 

3 Add a row or a column from the options as shown in Figure 2.5.

Figure 2.5. Adding rows and columns

Tips
 \ You can also add a row by clicking outside the last cell

of any row and pressing the E key.

 \ Right click on the cell > Insert > Insert Rows Above or

Insert Rows Below

 \ Right click on the cell > Insert > Insert Columns to the

Right or Insert Columns to the Left

C. Deleting a Cell, a Row or a Column
1 Position your cursor in a cell 

2 Click on Layout tab

3 Click Delete and pick your option to delete 
cell, column or row as shown Figure 2.6. 

Figure 2.6. Deleting cell, row or column
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D. Merging Cells
Merging cells refers to joining two or more cells in a table into one cell. 
This is usually done to create common heading to rows or columns.

1 Select all the cells that you want to merge. 

2 Go to Layout tab > Merge Cells.

E. Splitting a Cell
Splitting cell refers to converting a single cell into two or more cells. 

1 Click in a cell or select multiple cells that you want to split 

2 Click Layout tab > Split cells.

3 Specify the number of columns or rows you want in the Split Cells 
dialog box (Figure 2.7).

Figure 2.7. Splitting cells

4 Click OK.

F. Text Alignment and Direction
There are different ways to align text within a cell. You can align text 
horizontally towards left, centre or right of the cell. You can align 
it vertically towards top, centre or bottom of the cell. You can also 
change text direction within the selected cell.
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1 Select the cell where you want to change text alignment or 
direction. 

2 Click on Layout tab

3 Click on one of the options in text alignment to align text as required, 
or click on Text Direction button change the direction of text as 
shown in Figure 2.8.

Figure 2.8. Text alignment

G. Applying Table Styles
Table Styles contain a set of tables which are already formatted with 
different colours, shadings, and borders.

1 Click anywhere within the table.

2 Click on Design tab.

3 Choose one of the styles from the list as shown in Figure 2.9.

Figure 2.9. Table styles
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H. Table Shading
1 Select the cells where you want to apply shading.

2 Click Design tab

3 Click on the black wedge  of  button

4 Pick a fill colour of your choice.

I. Applying Border
1 Select the cells where you want to apply border. 

2 Click on Design tab.

3 Click on the black wedge  of  button and choose 
Borders and Shading from the list.

4 Choose the required options as shown in Figure 2.10.
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Figure 2.10. Applying Borders and Shading
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Try This On Machine
Create and format a table similar to the one given below.  Note the 
border colours, text alignment, and shading applied to the table. Save 
the it as ClassTimetable.

2.3 Header and Footer

Header is the area in the top margin of each page in a document, and 
footer is the area in the bottom margin of each page in a document.

Any content placed in header or footer will show up in all the pages. For 
example, you can add school logo and school name in the header, and 
page number, time and date, file name, or author’s name in the footer. 
You can also change the contents placed in the header or the footer 
of a document..
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A. Insert Header or Footer
Follow steps below to insert a header or footer in your document.

1 Click on the Insert tab

2 Click the Header to insert a header or click on Footer to insert 
footer.

3 Choose one of the design styles from the options (Figure 2.11).

Figure 2.11. Inserting Header and Footer

4 Add required text or images in the header or the footer.
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B. Edit Header and Footer Contents
The contents of the header and the footer can be edited at any time 
by following the steps below:

1 Go to Insert tab > Header > Edit Header to edit header content. 
Go to Insert tab > Footer > Edit Footer to edit footer content.

2 Start editing the contents when you see the cursor in the header 
or the footer as shown in Figure 2.12.

Figure 2.12. Editing Header and Footer

While editing, you can easily switch between header and footer by going 

to Design tab > Go to Footer  or Go to Header  option.

Click  to go back to the main document after editing the 
header and footer contents.

Tips
 \ Double click on the header or footer area to insert or edit header

and footer.

 \ Double click on the main document to exit header or footer.
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C. Remove Header or Footer contents
Header and footer contents can be removed at any time by going to 
Insert tab > Header or Footer > Remove Header or Remove Footer.

D. Insert Page Number
1 Click on Insert tab.

2 Click Page Number under Header & Footer group (Figure 2.13).

Figure 2.13. Inserting page number
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3 Choose an option on how you want to place the page number in the 
document.

4 Choose a design from the available gallery of designs. Page number 
appears in the document.

5 Exit from Header or Footer.

Try This on Machine
Open ClassTimetable that you have saved earlier in this chapter. Add your 
name in the header of the document. Right align the text in the header. 
Select a built-in footer design with a page number.

2.4 Inserting Pictures

Picture generates interest among readers and can help make 
information clearer. You can easily add picture from your computer or 
your thumb drive to your document as shown below:

1 Click on Insert tab > Picture

2 Locate your picture from the Windows Explorer (Figure 2.14)

3 Click on Insert button

ICT textbook Class 6 2019.indb   31 7/17/2019   3:23:21 PM



Literacy with ICT

32 Reprint 2019

Figure 2.14. Inserting Picture

E. Formatting Picture
Now you know how to add picture, let us look at how to format it. 
Formatting picture in Word includes applying visual effects, cropping, 
arranging and resizing.

1. Applying Style
1 Select the picture
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2 Click on Format tab > More button from Picture Styles group 

3 Select the style that you want to apply from the list (Figure 2.15).

Figure 2.15 Applying Picture Styles

2. Applying Border
Follow the steps below to add border to a picture, change border 
colour and thickness.

1 Select the picture.

2 Click on Format tab > 

3 Select colour, thickness and style of border that you want to apply 
to your picture.
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3. Cropping a Picture
Cropping is used to trim or cut the sides of a picture. This is useful when 
we want to use only a portion of the picture. 

1 Select a picture

2 Click on Format tab > Crop  button

3 Use the cropping handles as shown in Figure 2.16 to adjust the 
picture.

Figure 2.16. Cropping picture

Do You Know?
Cropping does not permanently remove the cropped part of the picture. They are only hidden. The hidden partcan be viewed again by dragging the cropping handlesoutward from the picture.
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4. Resizing and Rotating a Picture
1 Select the image. Rotating and sizing handles appear as shown in 

Figure 2.17.

Figure 2.17. Resizing a picture

2 Hover the mouse pointer over any sizing handle. When the mouse 
pointer changes to double-sided arrow,  click and drag the handle 
inward or outward to resize. 
Grab the rotating handle and turn clockwise or anticlockwise to 
rotate the picture.

Try This on Machine
1. Insert a picture.
2. Change the style to Beveled Oval Black.
3. Apply yellow border to the picture with its width 3 pt.
4. Crop the picture.
5. Change its height to 3.5”.
6. Add a relevant header and footer.
7. Save your file as Picture.
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2.5 Inserting Clip Art

Clip art is a ready-made art or image you can be used in the content.

1 Click on Insert tab > Clip Art button 
Clip Art options appear in the task pane on the right of the 
document and follow the steps given in Figure 2.18.

Figure 2.18. Clip Art options
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2.6 Inserting WordArt

WordArt is a decorative text that can be added to a document.

1 Click on Insert tab > WordArt button

Next, choose a WordArt design from the gallery that appears and 
insert it in the document as shown below (Figure 2.19).

Figure 2.19. Inserting WordArt
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A. Formatting WordArt

1. Changing Text
1 Select the WordArt you want to edit.

2 Click on Format tab > Edit Text button 

3 Make changes to the text.

2. Changing the Style
1 Select the WordArt.

2 Click on Format Tab > Click on More button

3 Select a style that you want to apply from the list. 

2.7 Inserting Shapes

Word comes with a collection of shapes which can be used to draw 
lines, boxes, arrows, callouts, stars and other shapes. 

1 Click on Insert tab > Shapes button 
to show a list of different shapes.
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2 Select the required shape. The mouse pointer will now change to  
shape.

3 Drag the pointer in the document to draw the selected shape.

A. Adding Text to Shapes
Sometimes, we may want to add text to the shapes. Follow the 
steps below to easily add text (Figure 2.20).

Figure 2. 20. Adding text to the shape
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B. Text Wrapping
Text wrapping is a feature that enables surrounding text to move 
around a picture, a diagram or an object.

1 Select the picture or object.

2 Click on Format tab > Text Wrapping button 

3 Select a wrapping option (Figure 2.21) that you want to apply from 
the list.

Figure 2.21. Text Wrapping options

With In Line with Text option, the picture aligns with the surrounding text 
and moves along as you edit the text. With other text wrapping options, 
the picture floats freely from the surrounding text. The picture does not 
move along within the same paragraph.

ICT textbook Class 6 2019.indb   40 7/17/2019   3:23:22 PM



Chapter 2 Advanced MS Word

41Reprint 2019

Tips
The default wrapping option for picture, clip art, Word Art and

chart is In Line With Text, and for shapes, it is In Front of Text.

2.8 Inserting Symbols

A sign, mark, letter or figure that is used to represent something. For 
example, % represents percentage, $ for dollar, © for copyright and  
for happy.

1 Click on Insert tab > Symbol button > More Symbols...

2 Next, pick a symbol from the Symbol dialog box that appears and 
insert it as shown below (Figure 2.22).

Figure 2.22. Inserting symbols
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Try This on Machine
1. Using clip arts, shapes and pictures, create a simple comic strip of

conversation between you and your friend. An example is given in
Figure 2.23 to help you get started. Save the document as My
Comic Strip.

Hi, I am Kinley.
What is your name? My name is Karma. It is nice to meet

you, Karma.

It is nice to meet
you, Karma.

That sounds great. Thanks
you for asking!

Cool. Let us go play!

Figure 2.23. Example of comic strip of conversation

2. Create a table containing symbols as shown below: Choose Wingdings
font when inserting the symbols.

 Thumbs up

 Khorlo

 Scissors

 Danger

 Tick

 Ten

 Mouse

 Happy
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2.9 Protecting Document with Password

We can use a password to prevent other people from opening our 
Word document. In this part, you will learn how to set and remove 
password for a Word document.

A. Setting Password
Open a Word document and follow the steps given below.

1 Click the Office button > Prepare > Encrypt Document (Figure 2.24). 

Figure 2.24. Setting password
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2 Type a password in the Encrypt Document dialog and click OK. Your 
password is shown as a set of black dots to prevent other people 
from reading your password easily.

3 In the Confirm Password dialog box, type the password again and 
click OK. 

4 Save the file. Now you will be required to type your password every 
time you open your document. 

Tips
 \ It is always good to use a password which is not easy to

guess. Memorize the password. If you forget it, you will 

not be able to open the document.

B. Removing Password
Open the document which is password protected. You will be asked 
to type password to open it. Once opened, follow the steps below to 
remove the password.

1 Click the Office button > Prepare > Encrypt Document.

2 In the Encrypt Document dialog box, delete the password (shown as 
black dots) and click OK.

3 Save the file.

Try This on Machine
Open any Word document you have created and protect it with 
a password. Try opening your password protected document with 
incorrect and correct passwords to see if it is working properly.
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Now You Know

1. Under the Insert tab, there are many tools for adding objects such
as pictures, clip arts, shapes and WordArt as well as symbols and
header and footer.

2. Objects are useful for making your document attractive and showing
your information pictorially.

3. Information can also be organized using tables.

4. Applying picture styles, effects and colour makes object look
better.

5. We can use text wrapping to arrange text around objects.

6. Header and footer are used to insert text and pictures that
appear on all pages.

7. Word document can be protected by setting a password.

Check Your Progress

1. Do the following tasks:

a. Insert a table with 5 rows and 2 columns.

b. Type the heading for the columns as Shapes and Description.

c. Under the Shapes column, insert a circle, a triangle, a square
and a rectangle in separate rows. Use different outline and fill
colours for shapes.

d. Use text wrapping In Line with Text for shapes.

e. Under the Description column, describe the shapes you have
inserted.
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f. Write Mathematics in the header, and your name and page
number in the footer.

g. Set the table border to 3 pt.

h. Give a title for the table using WordArt.

i. Protect your file with a strong password.

Explore Further

1. Draw the life cycle of an animal using SmartArt. Add relevant text
and pictures.

2. Create the poster shown in Figure 2.25 of classroom rules on being
a good listener.

Figure 2.25. Sample poster of classroom rules
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Web Links

1. Text wrapping
 K http://wordribbon.tips.net/T009382_Understanding_Through_

Text_Wrapping.html 

2. Pictures
 K http://www.gcflearnfree.org/word2007/16 

3. Header and footers
 K http://www.gcflearnfree.org/word2007/18 

4. Create password for a document
 K http://www.wikihow.com/Make-a-Password-Protected-Word-

Document
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CONNECT AND COLLABORATE

In this Chapter
3.1  Computer Network
3.2  The Internet
3.3  Connecting to the Internet
3.4  Web Address
3.5  Online Collaboration

Learning Objectives
1. Define a computer network.
2. List required devices for the

Internet connection.
3. Identify general web address

structure.
4. Discuss ideas using an online

collaboration tool.

3
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3.1 Computer Network 

A computer network is a group of computers connected with one 
another using cables, telephones lines, modem, cellular radio or satellite. 
Computers are connected in a network for the purpose of sharing 
resources like hardware devices, software programs, data and 
information. When your computer is connected to a network, you are 
said to be online.

Do You Know?
A computer that is connected to network is calledworkstation or node.

There are many advantages of setting up a computer network. Some of 
the benefits of networking are:

» Quick communication: Users on network can communicate
with each other using technologies such as instant messengers or 
electronic mail. It allows users to communicate easily, cheaply and 
instantly from anywhere in the world. 

» Resource sharing: Sharing of hardware devices and software
programs is easier and cheaper on network. For example, a printer 
can be shared by many users on a network to save cost. It is also 
cheaper to buy software licence for a network than for individual 
computers.

» Data sharing: Instead of using an external storage disk such as
portable hard drives or thumb drives to transfer files from one 
computer to another, we can share files directly through a network.
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» Internet access: Network allows multiple users to share a single
Internet connection.

» Data security and management: Access to resources and
data in the network can be controlled. Depending on how sensitive 
the information is, users can be given different level of access to 
the shared resources.

» Entertainment: Network allows to play multi-player games and
broadcast video and audio to many users at the same time.

Do You Know?
The network administrator is the person looking after theoperations of the network.

Computer network is classified into three types based on the area of 
its coverage. 

1. Local Area Network (LAN)
LAN is a connection of computers and devices in a small 
geographical area such as a school, a home or an office. 

2. Metropolitan Area Network (MAN)
MAN is larger than LAN and usually covers the geographical area 
of a city. A MAN includes one or more LANs. 

3. Wide Area Network (WAN)
WAN covers a large area such as the entire country or the entire 
world. It includes multiple LANs or MANs. The Internet is an example 
of WAN.
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3.2 The Internet

The Internet is a network of networks that connects computers 
all over the world. The Internet is widely used since it offers many 
services at our fingertips. We can send messages, meet new friends, 
play games, listen to music, invest in business, do banking, carry out 
research, watch movies, buy or sell products, shares resources, conduct 
video conference, use programs and many more. 

The U.S. Department of Defence (DoD) laid the foundation of the 
Internet in the 1969 by linking computers on a network called 
ARPANET (Advanced Research Project Agency Network). It
connected different universities and research centres of USA to share 
information on research and development in scientific and military fields. 
The success of this program gradually lead to connection of more 
computers from across the world. This gave birth to what we now call 
as the Internet.

3.3 Connecting to the Internet
To connect to the Internet (Figure 5.1), we need:

1. A computer system - Any computer can be used to connect to
the Internet through a modem.

2. A modem - Modem is a device that allows information to be sent
and received through a telephone or cable line. It is connected 
either internally or externally to the computer.

3. A telephone line or cable - A telephone or cable line connects
the modem to the Internet Service Provider. 

4. An Internet Service provider (ISP) - An ISP is a company or
an agency that provides Internet services for a fee. A user has to 
register with the ISP to get an Internet connection. DrukNet and 
Tashi InfoComm Ltd are ISPs in Bhutan.
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Druknet OR
Tashi InfoComm

Internet

Ethernet cable

Computer System

Telephone line

Modem

Internet Service Provider

Figure 5.1. Connecting to the Internet
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Try This on Machine
Divide yourselves into five groups and find information on the topics from 
the Internet. 
Group 1:  Definition of computer network and types of computer 

network
Group 2: Advantages of network
Group 3: History of the Internet
Group 4: Uses of the Internet
Group 5: Devices required to connect to the Internet

3.4 Web Address
Many computers are connected to a network for sharing of resources 
and information. Each computer in a network is called a host and they
have a unique address that identifies it from the rest.

Some hosts, known as web servers, carry out special tasks of sharing 
resources and information in the form of websites. Each website is 
accessed using a unique URL called web address. It indicates the
location of a webpage or a file on the network.

The web address is divided into different parts as in Figure 5.2.

http://www.education.gov.bt

Stands for Hypertext Transfer Protocol. It is 
the communication format computers use to 

exchange information on the Internet.

Name of the website

Indicates the nature of 
the website

World Wide Web

This is the domain name, an 
address by which an organization is 

known on the Internet.

Country code

Figure 5.2. Web address
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Each part provides clues to where a webpage is loacted and who might 
be responsible for providing the information on that page.

The first part http:// is usually used in all webpages. It is a
communication format used to send and receive information on the 
Internet. The part after http:// mostly begins with the letters 
www (World Wide Web) followed by the domain name. A domain
name identifies the type of organization who may be either directly 
responsible for the information, or is providing the space to store the 
information. The three letters after the name shows the nature of the 
website. For example:

Domain extension Type of organization
.com Commercial
.edu Educational
.org Non-profit
.net Networking
.gov Government
.mil Military

.int International

Sometimes domain name ends with two letters. It identifies the country 
where the domain name is registered. For example:

Code Country
.bt Bhutan
.in India
.us United States
.au Australia
.ca Canada
.jp Japan
.sg Singapore
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Try This
Identify the type of website or country where it is registered.
1. www.pbskids.org
2. www.dzongkha.gov.bt
3. www.bbc.co.uk
4. www.army.mil
5. www.discoverykids.co.in
6. www.dictionary.com
7. www.kidoz.net

3.5 Online Collaboration

Group of people working together for a common goal over the 
network like the Internet is referred as online collaboration. Online
collaboration offers flexibility of working on a project without the need 
to be physically present at the same location.

There are many online collaboration tools on the Internet. Some common 
tools are blogs, wikis, forums, instant messengers, and social networking 
sites. These tools can be used in schools to promote student’s 
participation in learning. 

Large companies like Google and Microsoft provide free and paid online 
services for collaboration. Google Classroom is one such free service 
from Google, which is created for teachers and students to use it 
for their teaching and learning. In Google Classroom, students can 
participate in discussion, answer questions, upload assignments and go 
through the resources provided by the teacher.

You will need a G Suite for Education account to use Google Classroom. 
School teachers and students in Bhutan are provided with G Suite for 
Education accounts by the Ministry of Education. Your teacher will be 
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able to help you get your Google account and temporary password. 
Follow the steps given below to use Google Classroom:

1 Open the website https://classroom.google.com
2 Type your G Suite for Education username > Next > (Figure 5.3)

Type your temporary password > Sign in.

Figure 5.3. Google Classroom sign in page

3 Read the welcome message > Accept (Figure 5.4). If you are 
using Google Classroom for the first time, you will have to accept 
Google’s welcome message, which contains the terms of service and 
privacy policy.

Figure 5.4. Google terms of service and privacy policy
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4 You will be asked to change your password. (Figure 5.5) Remember 
to set a strong password as learned earlier in Class Five.

Figure 5.5. Change password

5 On the bottom-right corner, click on Student (Figure 5.6).

Figure 5.6. Using Google Classroom as student
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6 Click on + on the top-right corner > Enter Class Code (Figure 5.7) >
Join. Class Code will be provided to you by your teacher.

Figure 5.7. Joining a class

7 You have now successfully joined a class created by your teacher. 
You can now start answering the questions posted by the teacher 
or give your comments to the post or add your own post as shown 
in Figure 5.8.

Name of the teacher who 
created the Classroom

Name of Classroom

Announcement Post

Figure 5.8. Google Classroom Post - Announcement
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To add your post to the class in Google Classroom, follow the steps 
given below:

1 Click on  button.

2 Type the topic for your post in the space given in the post dialog 
box as shown in Figure 5.9.

Figure 5.9. Post dialog box

You have learned how you can work together on a topic in the Google 
Classroom. You have answered questions asked by the teacher. You 
also gave comments to what others have posted. So what started as a 
simple question by your teacher, or a post by your friend can become 
a discussion which involves all the students. Through such a discussion, 
you will be able to reach a common understanding. This process of 
working together on a topic in Google Classroom is an example of online 
collaboration.

Try This on Machine
Work in groups. The group members start discussion on any topic by 
creating a post using the Google Classroom. The discussion can be joined 
in by other group members though comments. Each groups should write 
a report using comments given by other groups on their post.
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Now You Know

1. A group of computers connected together to share data and
resources is called computer network.

2. The Internet is worldwide network of networks.

3. LAN, MAN, and WAN are types of network grouped by its area of
coverage.

4. Computer, modem, telephone line and ISP are required to connect
to the Internet.

5. Google Classroom is an online collaboration tool that can be used to
share and discuss ideas.

Check Your Progress

1. Fill in the blanks

(a) The computer network that covers the whole city is called
.........................................................................................

(b) When you are on a network, you are said to be .......................................................

(c) A device that connects computer to the Internet using
telephone line is called ..........................................................................................

(d) An agency that provides Internet services is called ..................................................

(e) Blogs, wikis, forums and instant messengers are examples of
..........................................................................................

(f) .bt in http://www.rcsc.gov.bt stands for ..........................................................................................

(g) The US Department of Defence started a network called
......................................................................................... which became the foundation for the 
Internet.
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2. Answer the following questions

(a) What type of network is used in your computer laboratory?
Why is it used?

(b) Is the Internet useful? Explain.

(c) Explain how you would connect a computer at home to the
Internet.

(d) What are the advantages and disadvantages of using online
collaboration tools?

Explore Further

1. Find and describe five websites with .bt in their URL. One website and
its description is given as an example.

http://www.bbs.bt is a daily news broadcasting website. It mostly provides news
on Bhutan.

2. Find out which ISP provides the Internet connection to your school?
Find out the monthly fee paid by the school.

3. In Google Classroom, make a new post with an interesting picture,
and ask your friends to comment on your post.

Web Links

1. Understanding web addresses
 K http://techwelkin.com/understanding-the-components-and-

structure-of-a-url

2. History of the Internet
 K http://www.history.com/topics/inventions/invention-of-the-

internet
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3. Modem
 K https://www.scienceabc.com/innovation/what-is-a-modem-

what-does-it-do-router-working.html

4. Online collaboration tools
 K https://globaldigitalcitizen.org/online-collaboration-tools-

teamwork

5. Computer network
 K http://www.tutorialspoint.com/data_communication_

computer_network/computer_network_types.htm
 K http://www.buzzle.com/articles/advantages-and-

disadvantages-of-computer-networks.html
 K http://www.spamlaws.com/network-advantage.html
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COMMUNICATE W
ITH EMAIL

In this Chapter
4.1  Introduction to Email
4.2  Login to Email
4.3  Email Basics
4.4  Email Etiquette

Learning Objectives
1. Exchange emails.
2. Follow email etiquette.

4
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4.1 Introduction to Email 

In class five, you have learned how to send messages to your friends 
on the school Local Area Network (LAN). You used LAN messenger 
software to do that. Another way to send messages to your friends 
is by using email (electronic mail). Email is a way to send and receive 
messages over the Internet. It is similar to postal mail, except that the 
messages are received and delivered over the Internet.

Read the table below to understand how postal mail compares to email.

Postal Mail Email
Address Tulsi Ram

Dagala Primary School
Chukha
Bhutan

tulsiram@education.gov.bt

Writing Message is written on 
paper.

Message is written on email 
program.

Content Packages with paper 
documents, books and 
objects.

Digital documents, files, images and 
video.

Delivery  - Envelope or packages 
delivered by people.

 - Send to one person 
at a time.

 - Message delivered over the 
Internet.

 - Can be sent to one person or 
many people at the same time.

Time Takes days or weeks. Instantly.

Cost of 
service

Usually expensive. Usually less expensive.
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4.2 Login to Email
We need an email account to send and receive emails on the Internet. 
There are many email service providers on the Internet. Some provide 
free services while others require monthly or yearly fees. Yahoo! Mail, 
Microsoft's Outlook.com, and Google's Gmail are some of the popular 
free email services.

In Chapter 3, you have learned how to use Google Classroom. It is 
one of the apps in G Suite for Education for online discussion and 
collaboration. It also simplifies classroom management for teachers 
by allowing them to create, distribute and grade assignments, post 
announcements, and generate and moderate discussions in a paperless 
way.

Another app included in G Suite for Education is Gmail, which is used for 
sending emails. Since Gmail is a part of G Suite for Education, we can 
use the same account that you used to sign in Google Classroom.

1 Go to https://www.gmail.com > Type your G Suite for Education
account > Click on Next button. (Figure 4.1)

Figure 4.1. Typing email address
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2 Type your password > Sign in (Figure 4.2).

Figure 4.2. Typing password

3 Accept Google Terms of Service and the Google Privacy Policy 
(Figure 4.3).

Figure 4.3. Google Terms of Service and Privacy Policy
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4 Change your password (Figure 4.4).

Figure 4.4. Changing password

5 Click on Gmail (Figure 4.5).

Figure 4.5. Google Apps
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6 Now you can see your Inbox, where all the emails you received will 
be listed. You should already see a few emails from Gmail as shown in 
Figure 4.6.

Figure 4.6. Main email box window

7 Once you have finished reading your emails, you should sign out of 
your email account. Click on your initial ( ) on the right-top corner 
of the email window and click on Sign out button as shown in Figure 
4.7.

Figure 4.7. Sign out button
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Try This on Machine
Work in group. Take turns to sign in to Gmail using G Suite for Education 
account. Sign out when you have finished checking your emails.

4.3 Email Basics
In this section, you will learn to send an email or reply to an email. Gmail 
window consists of the Navigation pane, the Message pane and the 
Compose pane as shown in Figure 4.8.

Navigation Pane is what you see on the left hand side such as Inbox,
Sent Mail, Trash and others. Inbox is where you receive all your emails. 
Sent Mail contains a copy of all emails you have sent and Trash keeps 
your mails when deleted from Inbox.

The Message pane on the right hand side will list emails. From here,
you can select an email to read.

Navigation Pane Message Pane

Figure 4.8. Email interface
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A. Writing and Sending Email
Writing an email is similar to writing a letter. You will need the address 
of the recipient, subject of the letter, salutation, body, closing and your 
name like you have learned in your English class. 

Let us look at the steps followed by Tulsi Ram, a student in Class 6A, 
writing an application asking for a leave, to his class teacher Ms Lhaki 
Selden whose email address is lhakiselden@education.gov.bt.

1 Click on  button in Navigation pane.

2 The New Message window or Compose pane appears, where you 
enter the address of the recipient and the details of your email as 
shown in Figure 4.9.

Type the email address of a person 
to whom you are sending.

Subject or purpose of your email.

Type the salutation, message and 
your name here.

Figure 4.9. Writing message in Compose pane

Tips
 \ You can add multiple email addresses by separating them 

with commas. 
E.g. teacher1@education.gov.bt, teacher2@education.gov.bt,
teacher3@education.gov.bt
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3 Once the email details are filled, click on Send button. Your email
will be sent to the address you have typed, that is to tulsiram@
education.gov.bt

Tips
 \ Email once sent cannot be stopped and changed again.

So always check your email once before clicking on Send.

4 Click on Sent Mail in the Navigation pane to check whether the mail
has been successfully sent as shown in Figure 4.10.

Figure 4.10. Sent Mail folder

Try This on Machine
Send an email to your friend sharing an interesting incident that 
happened during the last winter vacation.
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B. Reading and Replying Email
Tulsi Ram had sent an email to his teacher Ms Lhaki Selden requesting 
for leave. The teacher replies to Tulsi Ram’s email and grants him the 
leave. Follow the steps below to reply to an email.

1 Sign in to email account to check for new emails.

Shows who sent the mail, subject of the mail 
and the date or time it was received.

Number in parentheses shows total new mails received.

Figure 4.11. Checking for new emails

2 Click on new email to read it. In our example, click on the email sent 
by Tulsi Ram.

Figure 4.12. Reading new email

Caution
Do not open emails from unknown sender. Such emails could

be harmful to your computer.
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3 Click on Reply button, either at the top of the message or one 
below the message as shown in Figure 4.13.

Reply button

Figure 4.13. Selecting Reply button

4 Start writing your reply in the window that appears below the 
message. Click  button when you have finished writing as shown 
in Figure 4.14.

Figure 4.14. Writing in Reply window
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Try This on Machine
Your friend had earlier sent an email to you sharing an interesting 
incident that happened during the last winter vacation. Reply to the email 
describing how much you enjoyed reading his/her story.

C. Forwarding Email
When the email that is sent to you is sent to another person, it is called 
forwarding email. In our example, teacher Lhaki Selden wants to
let Principal and other teachers know about Tulsi Ram's leave. So, she 
forwards Tulsi Ram's email to them. The procedure for forwarding an 
email is similar to replying an email.

1 After reading the email, select Forward button from the drop down 
menu at the top of the message as shown in Figure 4.15.

Figure 4.15. Choosing Forward button
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2 Enter the address of the person to whom you are going to forward 
the email as shown in Figure 4.16. If you want, you can also type 
your message below it. Click on  button when completed.

Figure 4.16. Entering address to forward email

Try This on Machine
Forward any email that you received earlier from a friend to other 
friends.
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D. Deleting Email
It is a good practice to manage your emails from time to time. If you 
think an email may not be useful in the future, you should delete it to 
save space of your email account.

Teacher Lhaki Selden recieves an email about Losar from Tulsi Ram. 
She reads it and thinks it is not important to keep it. So, she decides to 
delete it. Follow the steps below to delete an email.

1 Open an email you want to delete.

2 Click on  button from the toolbar to delete the email (Figure 
4.17).

Figure 4.17. Deleting email

Do You Know?
The emails you deleted are not removed permanently.  
They are usually kept in Trash folder for some time. If 
you delete it from Trash folder, then it is lost forever.
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E. Bounced Email
When an email cannot be delivered to an email address, it is sent back 
or bounced back to the sender with an error message. In Gmail, the 
message usually is "Delivery to the following recipient failed permanently: ..." as 
shown in Figure 4.18. Such an email is called a bounced email. It
occurs due to one of the following reasons:

1. recipient’s email address is incorrect,
2. recipient’s mailbox is full, or
3. mail server, which does the job of sending and receving emails, is too

busy and cannot handle request at that time.

Bounced Email

Figure 4.18. Bounced mail in a mailbox
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Try This on Machine
Write an email to your friend with the message to delete it once he or 
she finishes reading.

4.4 Email Etiquette

Etiquette is a set of accepted code of polite conduct or behaviours 
in a social group. Following proper etiquette will help you avoid 
misunderstandings, and you are less likely to offend people.

Technology has enabled people to easily communicate with anyone from 
anywhere at anytime. But how you communicate with others is no less 
important than communicating online, be it phone, email, instant message 
or video chat.

Here are some basic rules you can follow to write better emails, no 
matter to whom you are writing.

1. Reread the whole message before you send it.

2. Keep email short. Short messages are easy to read. Recipients are
less likely to read when the email is long. This does not mean you
cannot write long emails. You may write as long and as much as is
necessary but keep it to the point.

3. Write a good email subject. Be brief and clear about the message’s
purpose. Next to your name, email’s subject is the first thing your
recipient sees. It will help people receiving the email know right
away what the message is about.

4. Use correct English including punctuation. Check your message is
free of spelling and grammatical errors. Avoid using informal short
forms as in mobile text messages. It will make you look careless and
lazy.
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5. Be careful of what you write. There is an actual human being on the
other end of the computer. What you write could upset the other
person.

6. Keep formatting to minimum. Excessive text formatting such as using
many colours can make your emails difficult to read.

7. Do not write all in capitals letters. In online communication, writing in
all capitals is equivalent to shouting in message. Nobody likes to be
yelled at. It will annoy some people. Such a message is also not easy
to read.

8. Finish your message with proper closing such as "Thank you",
"Sincerely" or "Best regards". If you are in doubt which one is
appropriate, end your message with simple “Thank you”.

9. Keep your email signature short and simple. Email signature includes
sender's name and contact information such as phone number, email
address and website URL.

Try This on Machine
Write an email to a friend briefly describing an interesting book you 
read recently.

Now You Know

1. Email is a way of exchanging messages over the Internet.

2. Email works in a similar way as the postal mail.

3. Email address comes in the form of username@location such as
yeewong@yahoo.com, krishnagiri@gmail.com and mindu@hotmail.com

4. When you reply email, it is usually sent to the same person who
wrote you the email.
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5. When you forward email, it is usually sent to a person other than
the one who originally wrote to you.

6. It is a good practice to delete unwanted emails to save space of
your email account.

7. Good email etiquette will help you write emails which are short,
polite and easy to read.

Check Your Progress

1. A properly composed email includes

(a) recipient address

(b) subject

(c) message in the body

(d) all of the above

2. Shankar is the class captain for Class 6B. He is trying to send email
(Figure 4.19) to a new student Lhakpa, welcoming him to the class.
But he could not send it. Spot the error in the picture below and
explain what should be done to make it work.
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Figure 4.19. Shankar's email

3. Write TRUE or FALSE against each statement given below:

(a) Email deleted from your mailbox is permanently lost.

(b) We need a web browser and the Internet connection to use
email.

(c) A long email is easier to read than a short email.

(d) Emails are delivered instantly.

(e) Writing an email is similar to writing a letter.

Explore Further

Is there a way to send one email to multiple people at once? One way is 
to add multiple email addresses in To box (Figure 4.20). Explore another 
way to do it.

ICT textbook Class 6 2019.indb   83 7/17/2019   3:23:38 PM



Literacy with ICT

84 Reprint 2019

Figure 4.20. To box in Compose pan

Web Links

1. General introduction to email
 K http://www.gcflearnfree.org/emailbasics/email101

2. Various tutorials on Gmail
 K http://www.gcflearnfree.org/gmail

3. Email etiquette
 K http://www.entrepreneur.com/article/228787
 K http://email.about.com/od/emailnetiquette/tp/core_netiquette.

htm
 K http://www.gcflearnfree.org/emailbasics/email101/4.4
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COMPUTER AND HEALTH

In this Chapter
5.1  Computer Use and Health Issues
5.2  Preventing Computer-Related 

Health Issues

Learning Objectives
1. Explain common health issues

related to use of computer.
2.  Explain ways to prevent injuries

related to use of computer.

5
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5.1 Computer Use and Health Issues

Try This
State whether you agree or disagree with the following statements.

(a) Headache is a common problem with people who use computers for
a long duration.

(b) It is possible to get addicted to computers like getting addicted to
chewing doma.

(c) Using computer frequently helps to keep our body fit and healthy.
(d) Using computer regularly for long duration may lead to children

becoming overweight.
(e) People who use computers for long hours do not suffer from stress.

We have learned in previous classes about the benefits of using 
computers. We have come to know that computers are being used 
productively in many fields. Many office goers, university graduates, 
and school students use computers. But, not many are aware of health 
issues related to prolonged and incorrect use of computers. In this 
chapter, we will discuss some of those health issues:

A. Muscle and Joint Pain
People using computers for long hours often complain about muscle 
and joint pains. Muscles and joints can become stiff and painful due to 
either sitting in one place for a long duration or working on computer in 
awkward postures.
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B. Back, Neck, and Shoulder Pain
Use of inappropriate chairs and tables while working on computer leads 
to sitting in awkward postures. That puts pressure on the back and neck 
areas, sometimes causing stiffness and swelling in these parts.

C. Arm, Wrist, and Finger Pain
Pain in the arm, wrist, and finger can be caused by working with bent 
wrists, repetitive use or lack of rest for the hands and forceful hand 
motions. Typing and clicking a mouse button may seem harmless but doing 
it again and again without breaks can eventually cause pain.

D. Eye and Vision Problem
Eye problem is a common issue with computer users. Using computer for 
long duration can result in overworking of muscles in the eye that could 
lead to blurred vision, itchy eyes, and inability to see colour. Eye problem 
can lead to headache. It has also been noticed that being too close or 
too far to the monitor, bright light and reflections on computer screen 
can strain our eyes.

E. Emotional Strain
Using computer for long duration to complete tasks in time will leave less 
time for face-to-face interaction with friends and family. Working under 
pressure or alone for long period can lead to emotional strain or stress. 

F. Obesity
Working on the computer involves less bodily movements. Without active 
exercise, spending more time on the computer can lead to obesity. 
Obesity is a term used to describe somebody who is overweight with a 
lot of body fats.
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G. Addiction
Some people develop heavy dependence on computer for entertainment 
such as games, movies, music, and surfing the Internet. Such excessive 
dependence on computer leads to computer addiction. For example, 
many young people become addicted to computer games. Game addicts 
find it difficult to stop playing games and feel sad or angry when not 
allowed to play. Some gamers have difficulty adjusting to real life after 
having spent most of their time in the gaming world.

5.2 Preventing Computer-Related Health Issues

Health issues related to computer use can be prevented by following 
correct postures and good habits as listed below:

» Arrange a comfortable chair and table.
Sit with your back straight and feet
resting flat on the floor as shown in
Figure 5.1.

» Adjust your chair and desk such that
your screen is either at your eye level
or lower.

» Place your keyboard next to the mouse,
at a height that lets your elbows rest
comfortably at your sides.

» Keep your wrist flat while typing
as shown in Figure 5.2. Use your
whole arm when moving the mouse. When
you are not typing or using the mouse,
remove your hands from the keyboard
and relax or stretch.

Figure 5.2. Wrist position

Figure 5.1. Correct posture
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» Adjust the screen contrast and brightness such that your eyes are
not strained. Tilt your screen to avoid reflection.

» Maintain a proper distance from the screen. Look away from the
screen time to time and focus on faraway objects. Blink regularly to
moisten your eyes. This will avoid dryness and burning in eyes.

» Take regular breaks about 10 minutes every hour from the
computer.

» Set a time limit for playing computer games to avoid non-stop gaming.
Instead, engage in playing outdoor games.

» Practise simple meditation or physical exercises and interact with
friends and families to relieve stress.

Try This
Redo the activity you did in the beginning of this chapter. Check if you 
answers have changed for each statement.

Now You Know

1.  Computer related health issues are mostly caused by wrong
postures and using computer for long period.

2.  Following correct postures and good habits while using computer can
prevent computer related injuries.
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Check Your Progress

Using the clues given below, complete the crossword puzzle.

ACROSS

1 We should adopt correct body ........................................... when using a computer.

4 If you feel the need to use computer and cannot stay away from
computer, you may be developing computer ...........................................

8 We should avoid non-stop gaming on computer and engage in
physical  ...........................................
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9 We must take regular ........................................... from computer screen to give
rest to your eyes.

DOWN

2 Bending over a keyboard when typing can cause ........................................... to
your back.

3 Using computer without a break for a long ........................................... is harmful to
our health.

5 Eating often and sitting long hours in front of computer without
any exercise may result in ...........................................

6 Playing ........................................... on the computer is exciting but it should be
limited to short periods.

7 Prolonged use of computer may lead to emotional ...........................................

Explore Further

What are the similarities and differences between computer addiction 
and television addiction?
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Web Links

1. Computer use and health issues
 K http://www.makeuseof.com/tag/5-reasons-working-with-

computers-is-bad-for-you-how-to-stay-healthy/
 K http://www.cyh.com/HealthTopics/HealthTopicDetails.

aspx?p=243&np=295&id=2375
 K http://www.thehealthsite.com/diseases-conditions/6-worst-

health-problems-common-with-computer-use-sh214/
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SEARCHING ON THE INTERNET

In this Chapter
6.1  Search Strategy
6.2  Citing Online Sources

Learning Objectives
1.  Use basic search techniques to

find information.
2.  Provide source of online

information.
3. Indicate ownership of one’s own

work.

6
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6.1 Search Strategy

Try This 
Identify and list the key words for each of the following questions:

(a) Which mineral is good for the formation of bones and teeth?
(b) Why do we celebrate Tshechu?
(c) What is the name of the famous tower in France?

We have learned in class five that the Internet is a vast source of 
information. It provides information on variety of areas including health, 
business, government, career, education, entertainment, religion and 
news. Given the huge amount of information on the Internet, it would 
have been difficult if there were no search engines. Search engines 
help users to locate information on the Internet quickly. Using words or 
phrases in the search engine will result in hundreds of links on a topic. 
Using good search strategy will help to find specific information quickly. 
Search strategy is a way of using the keyword or phrase that will 
narrow the search results. Let us now look at some search strategies.

(a) Keyword Search
It is a form of searching on the Internet using a keyword. A keyword is 
one or more words taken from a question, which is used to search for 
an answer or a piece of information for the question. A simple way to 
get a keyword from a question is by

» identifying the main words,

» ignoring the common words and punctuations,

» adding words that give similar meaning.
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For example, let us look at the question In what ways are acid 
useful to us?. The main words can be acid and useful to make the
keyword useful acid. The result of this keyword search will display a
list of links on useful acid.

If the search results do not provide relevant information to your 
question, you can refine your search by changing keywords. For 
example, the keyword useful acid can be changed to uses of acid
to get more appropriate information for the question.

Do You Know?
 \ Upper case or lower case keyword will give the

same result in most search engines.
 \ Alan Emtage created the first search engine

called Archie in 1990.

(b) Phrase Search
Searching for information using a keyword within quotation marks is 
called phrase search. The quotation marks tell the search engine to
look for information that matches the keyword exactly as enclosed in 
quotes. For example, "uses of acids" tells the search engine to look
for the phrase in the order it appears.

(c) Boolean Search
It is way of combining keywords with Boolean operators such as AND,
NOT and OR to further produce more relevant results.

The Boolean search operator AND narrows a search by finding the 
websites that use both the specified keywords. For example, Paro AND 
Airport will look for all the websites that has both the words. You can 
also use + symbol in place of AND. For example, Paro + Airport.
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The Boolean search operator NOT narrows a search by excluding the 
keyword that follows the operator. For example, Paro NOT Airport 
will look for only the websites with the word Paro. The search will not 
display any link to the word Airport. You can also use - symbol in place
of NOT. For example, Paro-Airport.

The Boolean search operator OR broadens a search to include results 
that contain either of the words you typed in. For example,  Paro OR 
Airport will look for all the websites that has either of the words.

Try This on Machine
You were given a science project to find out why an object weighs 
more on the Earth than on the moon.

(a) List the main words and frame a keyword.

(b) Note the differences in the search results as you carry out each
of the following tasks:

1. Use a keyword search to find the information.
2. Do a phrase search for the information.
3. Use Boolean searches to get the information.

6.2 Citing Online Sources 
You have learned how to search for information on the Internet. The 
information that we refer or gather from the Internet are ideas 
shared by other people. When we use information shared by others, it is 
important and morally right to mention or cite the source of information 
in your work. Mentioning or citing a source means telling your readers 
that certain information in your work is not your original idea but came 
from another source. The source can be mentioned within the text 
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or at the end of the text. This process of mentioning the source of 
information in your work is called citation.

Citing the source of any information taken from the Internet in your 
work is important because:

» It tells readers how much reading you have done for your work.
» It points your readers to the sources you have used.
» It avoids plagiarism. Plagiarism is a form of cheating where you use

someone else’s ideas and present them as your own.
» It acknowledges other people’s work.

Even in our own work, we mention our names so that people will know 
that you are the writer or author of the work such as magazine 
articles, paintings, essays, poems and books.

To cite the source of information taken from websites, we need to 
have the following information:

1. Author of the article
2. Title of the article
3. Year of posting the article
4. Date of accessing the webpage
5. The URL of the webpage

As an example, let us now look at the Figure 6.1, webpage http://www.
bbs.bt/news/?p=57274 and find information required to cite its source.
1. Author: Cheten Dupchu
2. Title of the article: Bhutan wins 16 medals in South Asian Games
3. Year of posting the article: 2016
4. Date of accessing the webpage: 20 August 2016
5. The URL of the webpage: http://www.bbs.bt/news/?p=57274
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Figure 6.1. Online article
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Now that you have gathered the required information, you are ready 
to cite the source of information in your work. There is a correct way 
of writing it. Given below is one format of citation, which is added at the 
end of the text.

Author (Year, Month Date). Title of article. Retrieved from URL

Following this format, our earlier example (Figure 6.1) will, be cited as

Cheten Dupchu (2016, February 16). Bhutan wins 16 medals 
in South Asian Games. Retrieved from http://www.bbs.bt/
news/?p=57274

Some webpages may not provide name of author or date. In such 
cases, you mention the title, date of referring the article and its URL.

Try This on Machine
(a) Refer the following websites and write about balanced diet in MS

Word.

» http://www.wikihow.com/Maintain-a-Balanced-Diet

» http://www.healthline.com/health/balanced-
diet#AchievingaBalancedDiet4

» http://www.caloriesecrets.net/what-is-a-balanced-diet-and-why-
is-it-important/

» http://www.nhs.uk/Livewell/Goodfood/Pages/Healthyeating.aspx

» http://daniyasheikh.hubpages.com/hub/What-Is-A-Balanced-Diet-
Definition-Tips-And-Guide
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Your writing should cover the answers to these four questions:
» What is balanced diet?
» Why is it important?
» What are sources of balanced diet?
» Find out if your own diet is balanced?

(b) Cite the sources of the information, and include your name and class
at the end of your work.

Now You Know

1.  Information on the Internet can be searched quickly and
effectively by using search strategies like keywords, phrases and
Boolean operators.

2.  Keywords in quotation marks are used in phrase search.

3.  AND, NOT and OR are Boolean operators used in Boolean search.

4.  We have to cite the source of information taken from the websites
to acknowledge other people’s ideas.

Check Your Progress

1. Choose the most correct answer from the given choices.

a.  The Boolean operator which narrows the search by excluding
the keyword after it.

 • AND  • NOT
 • OR  • NEAR
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b. Following are the reasons for citation, EXCEPT
 • To list the sources.
 • To copy other people’s ideas.
 • To avoid plagiarism.
 • To acknowledge the author.

c.  Which search strategy uses the keywords within the quotation
marks to search for information?

 • Boolean
 • Keyword
 • Phrase
 • Google

d. Which search description will give the best result to search
information about History of Bhutan?

 • History OR Bhutan
 • History AND Bhutan
 • History IN Bhutan
 • History NOT Bhutan

e. Presenting somebody’s idea as your own without
acknowledgement.

 • Citation
 • Plagiarism
 • Sharing
 • Referencing

f. We have to look for the following areas to cite an information
from a website, EXCEPT:

 • Author of the article.
 • Title of the article.
 • Date of accessing the webpage.
 • Name of the search engine.
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g. It is a way of acknowledging other people’s ideas which you
have used in your work.

 • Plagiarism
 • Citation
 • Search strategy
 • Ownership

Explore Further

There is another way to search information on the Internet called 
wildcard search. Using the search strategies you have learned, find
out:

1.  What is a wildcard search?

2.  What are the common wildcard characters?

3.  When do you use the wildcard search?

4.  Use the wildcard search strategy to search information on the
Internet.

Web Links

1. Citing Source of Online Information
 K http://blog.apastyle.org/apastyle/2010/11/how-to-cite-

something-you-found-on-a-website-in-apa-style.html
 K http://libguides.mit.edu/citing
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INTERACTION IN SCRATCH

In this Chapter
7.1  More Control Blocks
7.2  Events Blocks
7.3  Coordinates
7.4  Operator Blocks
7.5  Sensing Blocks
7.6  Writing Algorithm

Learning Objectives
1.  Use Control blocks in an

animation to make a decision.
2. Use Events blocks to communicate

between Sprites.
3. Use Sensing blocks in an

animation to interact with users.
4.  Use algorithm to solve a complex

problem.

7
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7.1 More Control Blocks

In class five, we have learned the functions of some Control blocks such 
as repeat, wait, sensing, if-then, and if-then-else. We can also make 
the Sprite perform a task repeatedly until a given condition is met, or 
stop script in the animation. This can be done by using some other blocks 
under Control category.

Let us discuss the following blocks:

A. repeat until block
This block runs the blocks inside it repeatedly until the condition set for 
the block is true (Figure 7.1).

Condition blocks 
are placed here.

Figure 7.1. Using repeat until block

Example: Script to make Sprite move until it touches the edge of the 
stage (Figure 7.2).

Figure 7.2. Example of using repeat until block

B. wait until block
This block waits until the condition set for the block is true. When the 
condition becomes true, it runs the blocks below it.

Example: Script to play sound when spacebar is pressed on the 
keyboard (Figure 7.3).
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Figure 7.3. Example of using wait until block

C. stop block
This block stops the script. It has three options all, this script and
other scripts in sprite as shown in Figure 7.4.

Figure 7.4. Options available in Stop block

1. all - Stops all the scripts for all the Sprites in the animation.

2.  this script - Stops the script this block is attached to.

3.  other scripts in sprite - Stops other scripts for a particular
sprite.

Example: Script to stop a moving Sprite when it touches a specific 
colour (Figure 7.5) .

Figure 7.5. Example of using Stop block
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Try This on Machine
1. Create an animation in which a Sprite stops when "H" key is pressed.
2. Insert another Sprite to the animation and it should move only when

"S" key is pressed.
3. Make the second Sprite produce sound when it touches the first

Sprite.

7.2 Events Blocks
In class five, you have learnt to use events like clicking on Sprite and 
pressing a key on the keyboard to run an animation. Animations in 
Scratch can be made more realistic by making Sprite and Sprite, or 
Sprite and Backdrop to interact between themselves. This is done by 
sending and receiving broadcasts. A broadcast is a message that is sent 
to all the Sprites and Backdrops in the animation.

A. broadcast block
This block sends a message throughout the animation. The message is 
identified by a name. Follow the steps given below to send a message:

1 Click on dropdown menu > new message (Figure 7.6)

2 Give a name to the message in the textbox of the New Message 
dialog box.

3 Click Ok. 

Give a name in 
the text box

Figure 7.6. Specifying a message
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B. when I receive block
This block runs the script below it when a specific message is received.

Example: To play a sound when the message "Make a sound" is received 
(Figure 7.8).

C. broadcast and wait block
This block broadcasts the message and waits for the receiving blocks to 
complete running the scripts attached to them before continuing.

Try This on a Machine
Create an animation in the following sequence:
1. Sprite Calvrett asks Sprite Dan to sing a song.
2. Dan sings a song.
3. Dan asks Calvrett whether he liked it or not.
4. Calvrett replies that he really enjoyed listening.

Figure 7.8. Play sound when message is received
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7.3 Coordinates

A. Coordinates
Stage is a 2-D coordinate plane with x-axis and y-axis as shown in
Figure 7.9.

Figure 7.9. 2-D coordinate plane.

X-axis goes from side to side while Y-axis goes up and down. Every
point on the stage has a position on the x and y axes.  We write that
position in parentheses, and put the x and y position separated by a
comma (x, y). This pair of numbers is called coordinates.

For example in (-75, 40), x position is -75 and y position is 40.

Center of the stage is represented by coordinates (0, 0), zero for
x-axis and zero for y-axis. This point is also known as origin.
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Tips
 \  X position value determines the horizontal location of the

Sprite. 

 \ Y position value determines the vertical location of the

Sprite. 

 \ X position can range from -240 to 240.

 \ Y position can range from -180 to 180.

 \ When a Sprite moves a step, it covers a distance equal to

one pixel.

 \ Pixel is the basic unit on the screen.

B. Setting X and Y Positions

1. set x to block
This block sets a Sprite’s  x coordinate to a specified value.

2. set y to block
This block sets a Sprite’s y coordinate to a specified value. 

3. x position block
This block stores and displays x coordinate of a Sprite. 

4. y position block
This block stores and displays y coordinate of a Sprite. 

x and y position blocks are also called Stage monitors. These blocks
must be checked from the Blocks palette to actually display the 
positions on the Stage as shown in Figure 7.10.
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Figure 7.10. Displaying the Sprite's coordinates on the Stage

C. Drawing Shapes on a Coordinate Plane
In class five we have learned to draw shapes by specifying angles. 
Shapes can also be drawn by specifying the coordinates. 

Steps to draw a shape:

1 Insert XY-grid as a Backdrop.

2 Insert a Sprite of your choice.

3 Determine the shape and the coordinates of its corners.

4 Determine starting coordinates to draw the shape.

5 Use appropriate blocks (move, go to, change y by, change x by and 
pen down) to draw the shape.
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Example: Rectangle with coordinates (-100, 0), (-100,100), (100, 100) 
and (100, 0) can be drawn with the script shown in Figure 7.11. 

Figure 7.11. Rectangle on XY-grid and its script

Try This on Machine
Draw a hexagon, parallelogram, trapezium, kite and rhombus.

7.4 Operator Blocks

We can perform logical and mathematical operations in Scratch. 
Operators category has a number of blocks used for mathematical and 
logical operations.

The functions of some of the Operators blocks under Operators 
category are as follows:

Script

ICT textbook Class 6 2019.indb   111 7/17/2019   3:23:46 PM



Literacy with ICT

112 Reprint 2019

A. add block
This block adds two numbers and reports the sum.

B. subtract block
This block subtracts second number from the first number, and reports 
the difference.

C. multiply block
This block multiplies two numbers and reports the product.

D. divide block
This block divides first number by the second, and reports the result.

For example, in the script in Figure 7.12, the Sprite displays the answer 
after division for 10 seconds.

Figure 7.12. Sprite reporting the result of an operation

E. join block
This block joins two values together and reports the result. Values can 
be text or numbers typed directly or from reporter blocks. Joining two 
or more values is called concatenation.
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For example, in Figure 7.13 A a user directly enters “hello” and “world” in 
join block. It combines these two words into one phrase as “hello world”.

Values (text or number) can be typed here

Figure 7.13 A. Joining values

Other blocks such as Operator blocks and Reporter blocks can also be 
dragged and placed inside the join block as shown in Figure 7.13 B. and 
Figure 7.13 C.

Figure 7.13 B. Joing Values

Figure 7.13 C. Joining values

Try This on Machine
Write a script in which a Sprite says “Any number divided by zero is 
infinity” when a number is divided by 0.
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7.5 Sensing Blocks
In class five, you have learned to add user's input like mouse click or 
pressing a key on the keyboard to run blocks. We can also make Sprites 
interact with users using Sensing blocks. Making Sprites ask questions to 
the user and display the user's input, and reporting mouse positions and 
clicks on the Stage are a few examples. 

The functions of some of the Sensing blocks under Sensing category 
are as follows:

A. ask and wait block
This block displays the text entered in the block in a speech bubble and 
an input box at the bottom of the Stage for the user to enter a value 
(text or number). It waits for the user to type in a value and send it to 
answer block by pressing enter key or clicking on tick mark at the end
of input box.

B. answer block
This block stores the user input.  It keeps updating the most recent 
input from the user. It can also be displayed on the Stage. To display 
the answer block on the Stage, check the check box in front of the 
answer block on the Block palette area.

For example, a script which asks the name of the user and then displays 
the name as shown in Figure 7.14.
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C. mouse down block
This block checks if the mouse is being clicked while the script is running.

D. mouse x block
The mouse x block stores and reports the mouse-pointer's current x 
coordinate as shown in Figure 7.15.

Figure 7.14. Example of Ask and Answer blocks
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E. mouse y block
The mouse y block stores and reports the mouse-pointer's current y 
coordinate as shown in Figure 7.15.

Figure 7.15. Example of mouse position blocks.

Try This on Machine
Make an animation where a Sprite moves continuously and asks your 
name when touched with a mouse pointer. After getting the answer, 
it says your name for 3 seconds and starts moving again. (Hint: forever 
block, if then else, ask block).

7.6 Writing Algorithm

For a complex problem, it is always better to split it into simpler units so 
that it becomes easier for us to solve it.

For example, in an animation a dog barks at a cat and chases it. The cat 
runs away from the dog and enters a house. The dog then stops outside 
the house.

ICT textbook Class 6 2019.indb   116 7/17/2019   3:23:47 PM



Chapter 7 Interaction in Scratch

117Reprint 2019

This whole process looks difficult and confusing. But we can simplify it by 
breaking down the process into small and separate units as follows:

Dog Cat Backdrop

1. Sees the cat.

2. Starts barking.

3. Follows the cat.

4. Stops at the
door.

1. Starts running when
the dog barks.

2. Moves towards the
house.

3. Enters the house.

1. Set the backdrop to
outside scene.

2. When the cat enters
the house, backdrop
changes to inside scene.

Now, as you can see it becomes easier to translate those steps into 
scripts in Scratch. Figure 7.16 shows the script for the dog.

Figure 7.16. Sample script for Dog

There are some important points to consider when writing an algorithm. 
A good algorithm generally has these features:

» Input: What do we need to provide?

» Output: What should I get at the end?
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» Steps in definite order (logical): What steps to follow to get
output?

» Doable steps: Can every step be done?

» Final steps: Do the steps come to an end?

Given below is the algorithm to find the sum of two numbers. Let us see 
if it is a good algorithm by checking for the features mentioned above.

Step 1: Start

Step 2: Provide two numbers to the computer 

Step 3: Add two numbers

Step 4: Show the sum

Step 5: Stop

From the above algorithm, it is clear that 

» we need to provide two numbers, which is the input.

» the sum of the two numbers is the output.

» the steps should be carried out in given order to get the output.

» all the steps are doable.

» the program comes to end when the last step is achieved.

The above algorithm to find the sum of two numbers in Scratch looks 
like in Figure 7.17. 

Figure 7.17. Sum of two numbers
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Try This!
Create an algorithm for a simple animated scene on a topic of your 
choice. Break down the scene into small sections of actions and 
dialogues. Write a program in Scratch to create the animation. 

Now You Know

1. If then else block runs a set of blocks depending on whether the
condition is true or false.

2. Repeat until block repeats the script inside it until the condition
becomes true, whereas wait until block pauses the script until the
condition becomes true.

3. We can stop either all the scripts or specific scripts using Stop
block.

4. Messages can be sent and received using Broadcast and When I
receive blocks.

5. Sprite can communicate using ask, broadcast, and When I receive
blocks.

6. Mouse action and position can be sensed and reported using Sensing
blocks.

7. Shapes can be drawn using coordinates.

8. Mathematical operations can be performed in Scratch.

9. We can concatenate values using join block.

10. It is easier to solve a problem by breaking it into smaller scripts.
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Check Your Progress

1. Answer the following

(a) What is the height and width of the Stage?

(b) What is the default coordinates of default Sprite Cat when a
new Scratch file is opened?

(c) Write different ways to bring Sprite to the centre of the
Stage.

(d) Differentiate between wait until and repeat until blocks?

2. State True or False

(a) We can place repeat block inside if then else block.

(b) Sprite can perform mathematical operations.

(c) To move the Sprite upwards we specify the x value.

(d) We can draw shapes only by using coordinates.

(e) Only two Sprites can communicate within an animation.

3. Fill in the blanks

(a) Coordinates for the midpoint of the right edge of the stage is
...........................................................

(b) The ........................................................... block stores and reports the user input.

(c) Broadcast block is used along with ........................................................... block.

(d) A reporter block that displays the value on the Stage is called
...........................................................

(e) Combining two or more values is called ...........................................................

4. Modify the blocks in the script shown in Figure 7.18 such that Sprite
moves to and fro on the Stage saying its coordinates after every
step.
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Figure 7.18. Script for the Sprite

5. In the script shown in Figure 7.19, a Cat commands a Crab to walk.
But the Crab does not listen to the Cat. Find out the problem and
correct the Script for Crab.

Figure 7.19. Script for the cat and crab

6. Create an animation in which four friends Cat, Gobo, Pico and Tera
go for a walk by the sea side. They are talking turn wise. They
continue until the cat signals that there is a tiger. On receiving the
signal, all four start jumping and running in four directions. If any one
of them collides with the tiger, it shouts “Tiger! Tiger!” and falls. If not,
they continue running in different directions.
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Explore Further

1. Create an animation to draw each of the following symmetrical
figures.

2. Create an animation for a short dialogue between a student and
a teacher. Animation must include scene change, Sprite motion,
backdrop change and costume change. You may create and add
your own sprites, background and sounds.

3. Create an animation in which a teacher asks student a question. If
the answer is correct, teacher praises by saying “Very Good” with
clapping sound. Else teacher says “You must study once again”. (Hint:
Use comparison operators)

Web Links

1. Broadcast
 K http://wiki.scratch.mit.edu/wiki/Broadcast 

2. Algorithms and Scratch program.
 K http://www.code-it.co.uk/scratch 

3. Scratch Resources
 K http://technologypainting.com/
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4. Coordinates in Scratch
 K http://www.multiwingspan.co.uk/scratch.php?page=coord 

5. Arithmetic operators
 K http://cnx.org/contents/97fc1f9c-bb27-42b2-8fca-
797754e8f1ef@1/Scr0340:_Arithmetic_Operators_#The_
Operators_panel

6. Creating Shapes
 K https://www.edutopia.org/blog/scratch-programming-drawing-
2d-shapes-dylan-ryder 
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END OF THE YEAR ACTIVITY
Key Skills:

1.  Using tables and objects in MS Word

2.  Using email

3.  Collaborating online

4.  Citing source of information

5.  Adding interactions in Scratch animation

Task

Every organism needs to obtain energy in order to live. For example, 
plants get energy from the sun, some animals eat plants, and some 
animals eat other animals. The sequence in which organisms obtain food in 
nature is called food chain.

1)  Create a main folder named project and create three sub folders
as images, word and scratch.

2) Discuss and agree on the topics to be included in the project using
the Google Classroom.

3)  Based on the topics you have agreed, search for
a) Images related to food chain and save it in images folder.
b) Information on food chain.
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4) In a Word document, organize the information on food chain using
tables, images, header and footer, and page number.

5) Give a proper citation of the sources of information at the end of
your document.

6)  Save the document as food chain in the folder word. Protect the
document with a password. 

7) In Scratch, create an interactive animation showing a food chain
and save it as animation in the folder scratch. Your animation
should have
a)  User interaction
b)  Message passing
c)  Decision making and repetition

8) Send an email to your teacher sharing your experiences in doing the
project.
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ASSESSMENT CHECKLIST
Name of the Student : .................................................................................................

Roll No: .............................   Class: .............................   Section: .............................

School : ............................................................................................................................

Tick (√) under the appropriate column 1, 2 or 3 against each core 
competency statement. The numbers, as described below, indicate 
the competency level of a student in each of the stated skills:

1 = Some of the time  2 = Most of the time  3 = All the time

For Explore Further activity, use tick (√) or cross ( ⅹ) to show 
whether the student was able to successfully do it or not.

Sl. #  Chapter 1 Core Competencies
Degree

1 2 3

1 Identify internal hardware components of a computer.

2 Describe the functions of internal hardware 
components.

3 Use folders to organize files in a computer.

Subtotal 1

Explore Further

a Find out and write down the names and functions of 
other parts of computer which has not been discussed 
in the class.

ICT textbook Class 6 2019.indb   127 7/17/2019   3:23:49 PM



Literacy with ICT

128 Reprint 2019

Sl. #  Chapter 2 Core Competencies
Degree

1 2 3

1 Use tables in a document.

2 Format objects in a document.

3 Insert header and footer.

4 Protect document with a password.

Subtotal 2

Explore Further

a Draw the life cycle of an animal using SmartArt. Add 
relevant text and pictures.

b Create a poster of classroom rules on being a good 
listener (as shown in the picture).

Sl. #  Chapter 3 Core Competencies
Degree

1 2 3

1 Define a computer network.

2 List required devices for Internet connection.

3 Identify general web address structure.

4 Discuss ideas using an online collaboration tool.

Subtotal 3

Explore Further

a Find and describe five websites with their URLs ending 
in .bt

b Find out which ISP provides the Internet connection 
to your school? Find out the monthly fee paid by the 
school.
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c In Google Classroom, make a new post with an 
interesting picture, and ask your friends to comment on 
your post.

Sl. #  Chapter 4 Core Competencies
Degree

1 2 3

1 Exchange emails.

2 Follow email etiquette.

Subtotal 4

Explore Further

a Is there a way to send one email to multiple people at 
once? One way is to add multiple email addresses in To 
box. Explore another way to do it.

Sl. #  Chapter 5 Core Competencies
Degree

1 2 3

1 Explain common health issues related to use of 
computer.

2 Explain ways to prevent injuries related to use of 
computer.

Subtotal 5

Explore Further

a What are the similarities and differences between 
computer addiction and television addiction?
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Sl. #  Chapter 6 Core Competencies
Degree

1 2 3

1 Use basic search techniques to find information.

2 Provide source of online information.

3 Indicate ownership of one’s own work.

Subtotal 6

Explore Further

a What is a wildcard search?

b What are the common wildcard characters?

c When do you use the wildcard search?

d Use the wildcard search strategy to search 
information on the Internet.

Sl. #  Chapter 7 Core Competencies
Degree

1 2 3

1 Use Control blocks in an animation to make a decision.

2 Use Events blocks to communicate between Sprites.

3 Use Sensing blocks in an animation to interact with 
users.

4 Use algorithm to solve a complex problem.

Subtotal 7

Explore Further

a Create an animation to draw each of the four given 
symmetrical figures.
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b Create an animation for a short dialogue between a 
student and a teacher. Animation must include scene 
change, Sprite motion, backdrop change and costume 
change. You may create and add your own sprites, 
background and sounds.

c Create an animation in which a teacher asks student 
a question. Teacher says “Very Good” and “claps” if 
the answer is correct. Else teacher says “You must 
study once again” if the answer is wrong. (Hint: use 
comparison operators)

Total A  =   Subtotals 1 + 2 + 3 + 4 + 5 + 6 + 7

=   ............................

Sl. # End of the Year Activity
Degree

1 2 3

1 Information on food chain organized and presented 
using various objects in Word.

(Assesses the ability of organizing information using 
tables, shapes, images, clip arts, page number and 
header and footer )

2 Files arranged in appropriate folders and sub-folders. 
Word document is password protected.

(Assesses the student's ability to password protect 
Word document and manage files in folders and sub-
folders)
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Sl. # End of the Year Activity
Degree

1 2 3

3 Proper citation included in the document.

(Assesses the student's ability to correctly cite the 
source of information in the document)

4 Experience of doing this activity shared to the teacher 
by email. 

(Assesses the student's ability to communicate through 
email)

5 Common topics for food chain agreed through Google 
Classroom.

(Assesses the student's ability to discuss ideas using a 
collaborative tool)

6 Food chain animated in Scratch using user interaction, 
loops and conditions.

(Assesses the student's ability to incorporate user 
interaction, loops and conditions in a program to make it 
interactive)

Total B

Total points scored = Total A + Total B = ................................

Score = Number of checklist items 3
Total points obtained

100
#
# ~

Grade = ..........................................

Note: Refer the table on page 134 to award grade.
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The achievement of learning objectives will be the focus of assessment 
for this course. This will include essential ICT knowledge, skills, values and 
computational thinking practices. This assessment comprises of two parts: 
the through-course assessment and the year end assessment, which
will be examined through observations, conversations and portfolios.

The through-course assessment tasks consist of Try This, Try This on 
Machine and Check Your Progress which are designed to gather the
evidence of student proficiency in specific skills defined in the learning 
objectives.

The year end assessment requires students to apply the key skills they 
have acquired over the year in a holistic way. This is a project based 
assessment spanning over several periods. Sample project is included 
in the book but teachers may choose to create their own projects, 
modelled on the sample. Students should also be encouraged to come 
up with their own projects. Teachers should ensure that key skills learnt 
during the course are clearly identified and applied in the projects.

In doing the assessment, teachers should focus on observing and 
discussing: 

» how students carry out ICT supported learning.

» how students collaborate with peers, and seek support from parents
and teachers.

» how students are progressing in their learning on the basis of work
they are doing or have completed.

ASSESSMENT PLAN
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They should be given ample support and feedback to develop their 
competency in the key skills before they are assessed. This is to ensure 
that the nature of assessment is mostly formative as envisioned for this 
curriculum.

Assessments are done through checklists based on the learning 
objectives. Student’s competency will graded in a scale of 1 to 3. Grades 
should be given after careful evaluation of how consistently the student 
has demonstrated the required competency. 

The overall competency of a student is determined on the basis of the 
cumulative score of through-course assessments and the year end 
assessment. Based on the student’s score, a grade from A to D will be 
awarded as per the table given below:

Score Grade Description

80% and 
above

A
Student is an expert in this area. He/she can provide 
guidance, troubleshoot and answer questions related to 
this area where the skill is used.

60% to 
79%

B

Student can perform the actions associated with this 
skill without assistance. He/She is certainly recognized 
amongst the peers as “a person to ask” when difficult 
questions arise regarding this skill. He/She might require 
help from the teacher once in a while.

40% to 
59%

C

Student is able to successfully complete tasks in this 
competency as requested. He/She will require help from 
the teacher time to time, but he/she can usually perform 
the skill independently.

Below 
40%

D
Student have basic knowledge and understanding from 
experience gained in a classroom. He/She requires help 
when performing this skill.
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Assessing Student Performance
Assessment is an integral part of teaching and learning. Teachers and schools 
are expected to conduct assessment to provide information about student’s 
learning to the learner, the teacher and the parent.

Assessment is broadly of two types: formative assessment and summative 
assessment. Assessment primarily carried out to help students to learn is 
usually called formative assessment or assessment for learning. It takes place 
continually as students are learning. Assessment which is primarily for other 
purposes is often called summative assessment or assessment of learning. It 
usually comes at the end of learning.

The table below shows how assessment is used for variety of audiences and 
purposes.

Assessment OF Learning Assessment FOR Learning
 - To monitor national standards.
 - To report on achievement to students 

themselves and parents.
 - To make teachers, administrators and 

politicians accountable.
 - To screen students for higher studies and 

employment.
 - To determine what courses students should 

take in school or university.

 - To help students to learn by 
diagnosing difficulties.

 - To support students to learn 
by providing feedback.

The distinction between summative and formative assessment can be confusing. 
After all, the results of assessment can often be used for both the purposes. 
When the results of assessment are used to evaluate student performance, 
it is called summative assessment. When the results of assessment are used to 
improve student performance, it is called formative assessment.

Assessment requires a variety of data-gathering methods, including observations, 
interviews, performances, and collections of student work.
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Literacy with ICT looks at assessment through three lenses: observation, 
portfolio, and conversation.

Observations
By observing learners as they engage in using ICT, teachers determine which 
behaviours students have demonstrated and those they are still working 
towards. This information helps teachers plan for instruction that will further 
develop student’s literacy with ICT.

Observation can be either direct or indirect. Direct observation is when you 
watch interactions, processes or behaviour as they occur, such as teacher 
watching student explore the Internet to find specific information. The teacher 
may focus on the student’s ability choose the right tool and the relevancy of 
the information retrieved. 

Indirect observations are when you watch the result of interaction, process 
or behaviour. For example, teacher can inspect the cleanliness of the computer 
laboratory to determine whether the students are following the laboratory 
rules. 

Effective observation involves proper planning to determine the focus of 
observation. For example, in order to know how well your student applied the 
strategy while playing logical games, the focus should be on looking at the time 
taken to complete the game.

Teachers could use checklist, recording sheet and field notes to help them 
observe student’s progress in use of ICT. 

Conversations
Assessing literacy with ICT involves setting learning goals, building criteria and 
giving and getting feedback. These conversations may be shared between 
students, between teacher and student or be self-reflective. They may also 
be student-led conferences involving parents. This type of conversation is an 
important part of reporting to you about your child’s literacy with ICT.
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An effective conversation provides an opinion concerning the strengths and 
weaknesses of the student. The result may be then used to plan and design 
future learning programs. 

Conversation may start with simple question of what their plan, quality of the 
work done and the results they achieved.

Portfolios
As they learn, students use portfolios to accumulate evidence of their literacy 
with ICT. These portfolios may be process or product portfolios, or a combination 
of the two. They may be paper-based or electronic. The electronic portfolio 
or e-portfolio may include images, audio, PowerPoint slides of the project, 
animation, video or a simple reflection. It can be used by teacher, parents and 
students themselves to document what they are doing (either day-to-day 
things or through their best work or improvements they’ve made).

Involving student actively in the portfolio process develops self-awareness, goal-
setting, and decision-making skills essential for lifelong learning. They integrate 
diverse experiences in their portfolio over time and assess their own progress 
based on evidence and criteria, thus fostering the sense of responsibility and 
ownership of their own learning.

Students can organize their portfolios, as blogs, reflections on wiki, discussion 
on forum, and podcasting and vodcasting their works.

Focus on Proficiency
Assessment in this curriculum is based on holistic assessment of ICT skills and 
knowledge. Component skills would not be isolated and individually assessed. 
Doing so places strong emphasis on ICT literacy. Instead, a checklist would 
be developed which will define children’s levels of performance or proficiency 
in each of the intended learning outcomes. It is hoped this will provide a good 
overview of children’s area of strengths and weaknesses to plan for future 
learning.
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